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DALIBuildings 2.0.10 Release Notes       
April 2015 

WHAT’S NEW  

LUX LEVEL MONITORING 

DALIBuildings can be configured to monitor the lux level of certain sensors. The lux level reading can be retrieved from OPC or 

Web Service. 

By default this feature is disabled. To enable it, please go to Tools > Service Options > Lux Level Poll. 

ECG GROUPING DURING FULL SYNC 

On a full sync option dialog, user can choose to perform ECG grouping as well. 

 

SWITCH’S ADVANCED TIMING CHANGES 

A few changes: 

 Advanced Timing settings are only configurable on the master switch (on DCDAL31M2PB) or on the first switch (on 

DCDALIO-0402). These settings will be taken as universal settings for all switches. 

 “Long Press Start” is no longer configurable. Pressing the switch more than the configured “Short Press Period” will be 

treated as a long press. 

BUG FIXES 

This release fixes the following issues: 

 Data length limitation on database export: when exporting to access database (mdb), some of the data is truncated 

resulting in data loss. For example: device location will be truncated to 20 characters only. The following properties are 

affected: 

o Device (description, location) 

o Input/Output (description, location) 

o Network Variable (description, location) 

 Ratio for daylight harvesting is inverted on the DCDAL31MPE sensors: the target with a higher ratio is quicker to dim up; 

instead it should have the same behaviour as DCDALMS360: slower to dim up. 

 Target issue for sensor with firmware 2.007 or above: when configuring sensor firmware 2.007+ for the first time, the 

targets are not written properly to the sensor. This release should fix this issue however if you are still experiencing this 

problem, please disable the options Settings > Optimise ECD Sync from the toolbar. 

 “Dim Up from Off” option is missing from a Rotary switch. 

 Lux Level Target on DCDALMS360 or DCDAL31MPE are not written properly if the value is higher than 255.  



DALIBuildings 2.0.9 Release Notes       
March 2015 

WHAT’S NEW  

SUPPORT FOR DCDAL31M FIRMWARE 2  

DALIBuildings version 2.0.8 or older will incorrectly identify DCDAL31M Firmware 2 as DCDAL31M2PB, meaning that user is 

allowed to configure features which are not available such as slave switch and LED colour. 

IMPORTANT NOTE: if your existing database already has DCDAL31M Firmware 2, you must re-scan the DALI line by clicking 

‘Analyse’ from the device list (no need to delete them from the database, just a re-scan). After rescan, DCDAL31M Firmware 2 

will be properly recognised. 

EXTENDED VERSION INFORMATION FOR ECD 

Extended Version information is now available from DALIBuildings. It will automatically be retrieved when addressing new ECDs. 

When scanning the DALI line, user has the option to retrieve this information as well. 

 

BUG FIXES 

This release fixes the following issues: 

 Broadcast target issue: after configuring an ECD’s target to a group/address, if the user decides to revert the target 

back to broadcast, the target is not properly synced to the ECD 

 Group selector on Line B issue: selector for Groups on Line B is not properly synced to the controller 

 Import/export issue: a few of the ECD properties are not imported/exported properly to the XML 

KNOWN ISSUES 

The following issue is known to exist in the software: 

 Ballast sorting for offline programming: when ballast is created during offline programming, sorting ballast will 

rearrange their order in the database. 

Workaround: please use a manual sorting by using the ‘Swap Address Only’ function. This feature will not rearrange the 

ballast address in the database. 

 Device location will be truncated to 20 characters when exported to legacy database format (mdb).  

Workaround: please limit device location to 20 characters only. 

We are actively working on a fix for this and will release an update as soon as possible. 

 

 

  



DALIBuildings 2.0.8 Release Notes       
December 2014 

WHAT’S NEW  

WIRING TEST ENHANCEMENT 

Previously wiring test only identifies ballasts. Now performing a wiring test will also identify emergency lights and ECDs. 

WEB SERVICE CHANGES 

Version 1.2 is now available. It has exactly the same functions as version 1.1, however it fixes a minor issue where some of the 

web service client cannot recognise the new functions that version 1.1 introduces (eg. GetControllersPointStatusFormatted ). 

WEB SERVICE MANAGEMENT TOOL 

Web service management tool is now available from Tools > Service Options. The settings available are: 

 IP Address & Port: forms the address where the client can consume the web service 

 Service Version: the version of web service that should be active; by default it will be Version 1.0 

 

IMPORTANT NOTE: when upgrading from a previous version of DALIBuildings, please manually set ‘Service Version’ to the 

desired version. By default it will be set to Version 1.0. 

BUG FIXES 

This release fixes the following issues: 

 After moving address, “Fail to move address” message is displayed even though the address is successfully moved. 

 Exporting controller data to legacy database (mdb) does not export the ECG settings such as MAX/MIN level, Fade 

Time, etc. 

 Unable to sync DC0402 with firmware 2.2. 

 ECDs from LineB are not displayed in the UI for Group configuration. 

 LED Mode: ‘Eco’ option is missing from switch with firmware 2.002 or above. 

 Default-focus issue (UI issue): some prompt dialogs are not given default focus, forcing the user to manually select the 

textbox to start editing. 

 

KNOWN ISSUES 

The following issue is known to exist in the software: 



 Ballast sorting for offline programming: when ballast is created during offline programming, sorting ballast will 

rearrange their order in the database.  

Workaround: please use a manual sorting by using the ‘Swap Address Only’ function. This feature will not rearrange the 

ballast address in the database. 

 We are actively working on a fix for this and will release an update as soon as possible. 

 

  



DALIBuildings 2.0.7 Release Notes       
October 2014 

WHAT’S NEW  

WEB SERVICE CHANGES 

This release introduces the following new functions: 

GetControllersPointStatusFormatted () 

Description: 

Returns a comma separated value of all points’ status from a controller. 

Parameters: 

Name Description 

siteId ID of the physical site address 

controllerId Controller’s Id. Valid value: 0-999. 

lineType DALI Line of the points. Valid value: 

 0: all DALI Line 

 1: Line A 

 2: Line B 

Return values: 

If all points from both DALI line is requested, the return value will be 128 values. However if only a specific DALI line is 

requested, only 64 values will be returned. Example: “4,0,4,0,256,256,…,256”. 

SendDaliCommandToPoint () 

Description: 

Send a DALI command to a single point or to all points. 

Parameters: 

Name Description 

siteId ID of the physical site address 

controllerId Controller’s Id. Valid value: 0-999. 

pointAddress Point’s address. Valid value: 

 0-63: a single point 

 255: broadcast 

lineType DALI Line of the points. Valid value: 

 0: all DALI Line 

 1: Line A 

 2: Line B 

isIndirectCommand Is indirect command? Valid value: 

 True: if DALI command (eg. MAX) 

 False: if ARC level 

command Command to be sent. Valid value: 

 Valid DALI command (eg. 5 for MAX) 

 ARC level (0-255) 

Return values: 

N/A (void) 

NOTE: 

This release also fixes the issue where DALIBuildings produces a misleading WSDL which exposes all functions as void even 

though they have return values. After upgrading, please update your web service client to use the new WSDL. 



LOCATION CHANGES 

Controller’s location is now a global setting. User can quickly set all controllers within a Site to have the same location (e.g. 

Melbourne). 

 

This release also enables user to sync location using the Sync-All feature. 

 

AUTOMATIC QUIET MODE 

During controller sync and ballast sorting, DALIBuildings will: 

 Inhibit the DALI line: so that sensors are not interrupting the ballast sorting process. 

 Stop the controller: if controller is on RUN mode, it will be put to STOP mode temporarily. Upon completion, it will be 

returned to RUN mode. By stopping the controller, the traffic on the DALI line will be reduced. 

SEQUENCE IMPROVEMENT 

When creating new sequence, user can specify a sequence Id, rather than using a determined sequence Id. 

Also DALIBuildings supports creating a single sequence to other controller(s). User can do this using the ‘Edit and Create New..’ 

feature. 

 

BUG FIXES 

This release fixes the following issues: 

 Default profile on ECD: after controller sync, ECDs failed to go to the default profile. Example: after upgrading 

controller’s firmware then performing sync, the controller will go to profile 1 but the ECDs stay on profile 4.  

 Ballast sorting: when sorting ballast, DALIBuildings failed to reflect the address changes to the database. 

 Scheduled Timer change: scheduling a change to a Timer was not supported. Now user is able to specify a date and 

time for a Timer to be reconfigured automatically. This is useful for special occasions which require a once-off Timer 

change. 

 Copy behaviour on offline ECD: some of the properties on an offline ECD failed to be copied to another offline ECD. 

 Database settings: editing the SQL Server name textbox freezes the UI. 



KNOWN ISSUES 

The following issue is known to exist in the software: 

 Ballast sorting for offline programming: when ballast is created during offline programming, sorting ballast will 

rearrange their order in the database.  

Workaround: please use a manual sorting by using the ‘Swap Address Only’ function. This feature will not rearrange the 

ballast address in the database. 

 We are actively working on a fix for this and will release an update as soon as possible. 

  



DALIBuildings 2.0.6 Release Notes       
September 2014 

WHAT’S NEW  

SQL SERVER INSTALLATION FIX 

This release fixes the SQL Server installation failure. On specific dates, the installer will fail to install SQL Server and returns with 

‘Out Of Range String’ error message. 

ECD CONFIGURATION FIX 

This release fixes the issue when syncing ECD. If the user only make a few changes (eg. change sensor detection mode from 

‘Presence’ to ‘Disabled’), those changes are not applied instantly by the ECD. 

WEB SERVICE HELP 

This release contains the help file for DALI Web Service. 

TREEVIEW AUTO REFRESH AFTER DATABASE IMPORT 

The TreeView will be automatically refreshed after a database import to reflect the new data. 

MINOR FIXES 

This release fixes the following issues: 

 Sorting Ballast: when sorting ballast with exclusion then going back to sorting all ballasts, the exclusion start address is 

still taken as the starting address. 

 Ballast Editor: ballast editor failed to load if there are duplicate addresses. 

KNOWN ISSUES 

The following issue is known to exist in the software: 

 Schedule Manager: currently scheduling a change to a Timer is not supported. Once this feature is enabled in the next 

release, user will be able to set a date and time for a Timer to be reconfigured automatically. This is useful for special 

occasions which require a once-off Timer change. 

 Sorting Ballast: when sorting ballast, the ECD sensors are not automatically inhibited so they can interfere the sort 

process by turning on or off the ballasts.  

Workaround: please manually disable or inhibit the ECD sensors before sorting ballast. 

 We are actively working on a fix for this and will release an update as soon as possible. 

 

 

 

  



DALIBuildings 2.0.5 Release Notes       

August 2014 

IMPORTANT NOTES 

 Before installing the software please read the accompanying document DALIBuildings Installation Guide. 

 

WHAT’S NEW  

 Single Software Solution 

 Faster Programming 

 Building-Mode View 

 Custom Zone Improvement 

 Web Service Interoperability 

 Robust Data Storage 

SINGLE SOFTWARE SOLUTION 

Instead of using different software to commission different part of the project, DALIBuildings can commission a DALI project 

from start to finish.  DALIBuildings has the functionalities from the following software: 

 DCBMManager: configures the DCBM controller 

 DCBMMonitor: configures Input/Output, Groups, etc. 

 DCBMWizard: configures ECGs and ECGs. 

 

 

 

 

 

 
 

 

Project-centric approach 

It also introduces a project-centric approach rather than previous controller-centric approach which means user is able to see all 

controllers from a project on one screen. User gets a structural view of the Network layout and it adds the ability to work cross 

controller (e.g. user can send ON/OFF command to a CustomZone which contains all lift lobbies from every level of a building). 

 



 

Compatibility with existing software 

DALIBuildings has the capability to import from existing databases, so existing project can be converted into using the new 

solution approach. This will add new benefits such as Web Service (for interoperable with other system, such as the 

HVAC/Security system) to an existing DALI site. 

FASTER PROGRAMMING 

With the project-centric approach of DALIBuildings, it enables user for faster programming. 

Edit multiple objects 

Some object such as Schedule, Holiday, and Sequence are likely to have the same configuration across all controllers. For 

example when we are adding a holiday, we would like to add the holiday to all controllers. DALIBuildings enables user to open a 

holiday as a template then copies the configuration to multiple controllers. 

 

Copy-paste 

Copy paste functionality lets the user choose an object as a template then paste it to other objects. Currently you can copy-

paste the following: 

 ECD behaviour: copy the configuration of an ECD except its target. 

 Controller’s base configuration: copy all Schedules, Holidays, and Sequences to another controller(s). 

 



 

 

Automatic queuing when syncing or upgrading firmware 

DALIBuildings enables user to sync or upgrade multiple controller. It then creates a queue and executes the task based on the 

queue. 

 

 

Faster ballast address sorting 

DALIBuildings utilises a new sorting algorithm to help user sort their ballast quicker.  

 

 

Program controllers and devices in offline mode 

DALIBuildings allow user to create controllers and devices in offline mode. This allow user to develop their site plan without 

waiting for the controller/device to be completely installed. Once the user is on site, they can initiate the discovery process and 

DALIBuildings will recognise and match the offline plan. 

 



 

If DALIBuildings could not match the OFFLINE plan with the actual controllers, user has the option to manually map a controller 

to an OFFLINE controller. 

 

 

  Offline editing for ballast settings 

Ballast settings are now stored in the database. This enables user not only to do offline programming but also to have a backup 

of the ballast settings. 

 

Better Fault-Finding/Analysis Tool 



Since DALIBuildings has all information from a project, analysing your project becomes easier. For example a typical fault finding 

is to find which ECG/ECD is causing problem in a Group. DALIBuildings will automatically scans the ECDs to find which one is 

targeting the faulty Group and display the list along with the ECGs. 

 

BUILDING-MODE VIEW 

DALIBuildings introduces a new view which simplifies the layout of the project. This view would be ideal when the project is in 

operational mode since the building operator does not need to know the physical layout of the project. 

Unlike the Network-Mode view, it only displays groups from a single level with the ability to do a quick search by the group 

name. 

 

CUSTOM ZONE IMPROVEMENT 

A more flexible CustomZone 

Instead of having CustomZone as a collection of controllers which share the same commonalities, CustomZone now can be 

configured as a selection of groups rather than controllers. This adds a greater flexibility when grouping groups from different 

controllers. 



 

Broadcast command 

DALIBuildings also add the capability to send command to a CustomZone, which will be translated into multiple commands to 

multiple controllers. Currently only ON/OFF commands are supported. 

WEB SERVICE INTEROPERABILITY 

DALIBuildings exposes web service functionality which enables interoperability with other system, such as StruxtureWare or any 

other system which understands XML web service. 

This enables the web service consumer to: 

 Retrieves up-to-date groups and points status 

 Send DALI command via the network 

DALIBuildings has its own web service server, so it does not depend on the installation of a separate web server. This means a 

simpler installation procedure. 

ROBUST DATA STORAGE 

DALIBuildings uses SQL Server as the database server. User can choose to download a specific DALIBuildings installer which will 

install an express edition of SQL Server 2008R2 (which gives us a huge storage of 10GB). 

Using a database server gives DALIBuildings some advantage: 

 Bigger size of database and better performance: since DALIBuildings are now acting as the data collection point for all 

DCBM controllers to report their up-to-date points and group statuses. 

 Advanced data operations such as: security, automatic backup, encryption, failover, and so many more that SQL Server 

offers. 

 Adds flexibility on integration and custom reporting: since SQL Server uses standard SQL queries, third party system or 

reporting engine can integrate easily to DALIBuildings database. 

 

UPGRADING FROM BETA VERSION 

MULTIPLE WINDOWS USER 



Generally user does not need to uninstall DALIBuildings BETA before upgrading to the full version. However if DALIBuildings 

needs to run under multiple Windows account then user need to uninstall DALIBuildings BETA and the SQL Server 2008 R2 which 

was installed by the beta installer. 

To proceed with the uninstallation of DALIBuildings BETA, please read and follow the accompanying document DALIBuildings 

SQL Server System Administrator. 

LICENSE DONGLE 

User must use a license dongle to run DALIBuildings. The BETA license no longer applies. 

KNOWN ISSUES 

DALIBuildings has the following known issues: 

 Schedule Manager: currently scheduling a change to a Timer is not supported. Once this feature is enabled in the next 

release, user will be able to set a date and time for a Timer to be reconfigured automatically. This is useful for special 

occasions which require a once-off Timer change. 

 TreeView does not auto-refresh when performing import from the TreeView’s context menu. 

Workaround: please use the import feature from the toolbar (File > Import/Export) or simply restart the application. 

 We are actively working on a fix for this and will release an update as soon as possible. 

 


